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1. Lwu y quan trong

S tay s dung dién t&r nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thoi gian doc sé tay st dung
nay trwéde khi st dung man hinh. Sé tay
bao gdm nhirng théng tin va cac lwu y
quan trong lién quan dén viéc s dung
man hinh.

Ché dd bao hanh cla Philips ap dung v&i
diéu kién la san pham phai dwgc st dung
dung cach theo muc dich s dung, theo
cac hwéng dan hoat dong cuing véi viéc
xuét trinh hoa don gbc hodc bién nhan
tién mat ghi rd ngay mua, tén ngudi ban,
mau ma va ma sb san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

® canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu ré trong tai liéu nay cé thé
khién nguwoi dung dé bj dién giat, gap cac
rai ro vé dién va/hodc co hoc.

Hay doc va thuc hién theo cac hwéng dan
sau khi két ndi va st dung man hinh may
tinh:

Hoat dong

+ Hay dat man hinh & khu vyc khéng cé
anh sang trwe tiép ctia mét, anh sang
ric c6 cweng dd manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh l1au ngay trong mdi trvdng nay cé
thé khién cho man hinh bj bac mau va
héng.

« Di chuyén moi d vat c6 thé roi vao
céac 16 théng gié ctia man hinh hodc
ngan can qua trinh lam mat thich hgp
cla céc thiét bj dién t&r bén trong man
hinh.

+ Khéng bit kin cac 16 théng gi6 trén v
man hinh.

Dam bao d&t man hinh & gan noi c6
phich c&m va & cdm dién.

Néu tat man hinh bang cach rat cap
ngudn hodc day dién DC, hay doi 6
giay truwéc khi cdm cap ngudn hodc
day dién DC dé man hinh hoat dong
binh thuwdng.

Hay ludn dung cap ngudn chuén duoc
cép bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tam thong tin tiéu dung
cham séc khach hang)

Khéng dat man hinh & noi bi chan
ddng hay va cham manh khi dang
hoat déng.

Khéng dap hoac lam roi man hinh khi
dang hoat déng hoéc khi di chuyén.

Bao dwdng

D& man hinh khéng bj hdng, khéng dé
nén qua manh Ién mat man hinh LCD.
Khi di chuy&n man hinh, hay ndm chat
khung man hinh d& nhéc Ién; khong
nh&c man hinh béng cach dat ban tay
hodc ngén tay Ién mat man hinh LCD.
Rt phich cdm man hinh néu ban khéng
dinh st dung n6 trong thoi gian dai.
Rat phich cdm man hinh néu ban can
lau chui man hinh bang mét miéng

vai hoi wét. Ban ¢6 thé lau man hinh
bang vai kho khi d& ngét dién. Tuy
nhién, dirng bao gi¢' dung dung mai
hitu co, chang han nhuw cdn hodc cac
chét 16ng c6 nguén gbc tir amoniac dé
lau man hinh.

D& tranh nguy co bi dién giat hodc
héng vinh vién bd man hinh, khéng
dat man hinh & noi cé bui, mwa, nwéc
ho&c & noi qua am wot.

Néu man hinh bj wét, hay lau né bang
vai khd cang sém cang tét.

Néu chét la hodc nwéc dinh vao man
hinh, hay ngat dién ngay va rit cap
ngudn. Sau d6 lau sach chat la hodc



nwéce rdi glri man hinh dén trung tam
bdo duwdng.

+ Khong cét gitr hodc str dung man hinh
& noi 6 ngudn nhiét, &nh nang trwc
tiép hodc qua lanh.

« D& duy tri hoat dong téi wu ctia man
hinh va st dung né trong th‘c‘yi gian dai,
hay dung man hinh & noi nam trong
gi6¢i han nhiét do va do &m sau.

* Nhiét dé: 0-40°C 32-95°F
« Do am: 20-80% RH

Théng tin quan trong vé Thir néng/Anh

béng ma.

* Luon béat trinh bao vé man hinh
chuyén ddng khi ban khéng st dung
man hinh. Luén bat trng dung lam méi
man hinh dinh ky, néu khéng, man
hinh cta ban sé& hién thi nhirng noi
dung tinh khéng thay dbi. Hién thj lién
tuc cac anh tinh trong mét thoi gian
dai co thé gay ra hién twong “anh thiy
ndéng”, con dwgc goi la “anh do0” hay
“anh bong ma”, trén man hinh cta
ban.

“Anh thir néng”, “Anh a0” hay “Anh
béng ma” la hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwong hop, hién twong “anh
thtr néng” hoac “anh ao” hay “anh
béng ma” sé& dan dan bién mét sau
mot thei gian man hinh bi ngét dién.

® canh bao
Khéng thé bat anh bao vé man hinh, hoac
trng dung cap nhat man hinh dinh ky cé

A

thé gay ra cac sw ¢ “thtr néng” hodc “anh
sau” hodc “anh bong ma” nghiém trong
vbn sé& khong bién mét va ciing khéng

thé khac phuc. Thiét hai vira néu khoéng
bao gdm trong chinh sach bao hanh cta
chung téi.

Dich vu
« Chi nhan vién dich vu chuyén moén
m¢&i dwoc mé vo boc man hinh.

+  Néu can moi tai lieu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (vui long tham khao
chwong “Trung tdm théng tin tiéu
dung”)

« D& biét thong tin vé viéc van chuyén,
vui 16ng tham khao muc “Théng sé k§
thuat”.

« Khéng dat man hinh trong xe hoi/cép
xe dwéi anh nang truc tiép.

& Ghicha

Hay tham khao y kién cla ky thuat vién
dich vu néu man hinh khéng hoat dong
binh thwong hodc néu ban khéng chéc
phai thwe hién quy trinh nao khi da lam
theo cac hwéng dan hoat déng néu trong
s6 tay nay.

1.2 M6 ta biéu twong

Cac muc phy sau day mé ta cac quy woc
vé biéu twgng dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
hodc in nghiéng. Cac doan nay bao gém
cac ghi chu, lwu y hodc canh bao. Ching
dwoc str dung nhu sau:

& Ghi chu

Biéu twong nay cho biét cac thong tin
quan trong va cac bi quyét gidp ban tan
dung tét hé théng may tinh.

O Luu y

Biéu twong nay cho biét cac thong tin gitp
ban biét cach tranh dwoc sw ¢ héng héc
tiém &n dbi v&i phan clrng hodc méat di
lieu.

® canh bao

Biéu twong nay cho biét sy tén thwong
co thé tiém an va gitp ban biét cach tranh
dwoc sw cd do.



Mot sb canh bao co thé xuét hién & nhiéu
dinh dang va c6 thé khéng di kém mot
biéu twong. Trong nhitng trwéng hop nay,
céach thirc trinh bay cu thé cta canh bao
doé dwoc quy dinh b&i co quan chirc nang
lién quan.

1.3 Virt bé san pham va vat liéu
déng goi

Thiét bj dién & dién te bj virt bo-WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2. Cai dat man hinh

2.1 Lap dat

El Noi dung g6i hang

%%art

- oo PHILIPS

*Tly vao quéc gia

* Depends on the country

B Lip chan dé

1. Dat man hinh nam sap trén bé mat
mém min, cn than dé tranh lam tray
xw@c hodc héng man hinh.

2. Gén try dé gitr vao man hinh cho dén
khi n6 khda vao thich hop.

3. Gitr chan dé man hinh bang cé hai tay
va lap chat chan de vao tru de.




El Két néi véi PC

‘ PHILIPS

© Dau vao ngudn dien AC

© Dbiu vao VGA

© Diu vao DVI-D (co sén cho cac mau
vira chon)

O Khda chdng trdm Kensington

Két néi véi PC

1. Cam chét cap ngudn vao mat sau cla
man hinh.

2. Tat may tinh va rat cap ngudn.

3. C&m cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

4. C&m cap ngudn clia may tinh va cap
ngudn ctia man hinh vao 6 cdm dién
gan do.

5. Bat may tinh va man hinh. Néu man
hinh hién thi h"lnh anh thi qua trinh cai
dat da hoan tat.

2.2 Str dung man hinh

E M6 ta mat trwéc cha san pham

~
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Truy nhép menu OSD.
@ |(©/0K|Xac nhan diéu chinh menu
OSD.
© 4 |Trévé mic OSD truwéc.
©® | & |Chinh do sang.
© | A ¥ [Chinh menu OSD.
O | A |Déidinh dang hién thi.
@ | AUTO [Tw dong chinh man hinh.




E M5 ta menu Hién thij trén man hinh

Hién thi trén man hinh (OSD) la gi?
Hién thi trén man hinh (OSD) la mét tinh
nang c6 & moi man hinh LCD cua Philips.
N6 cho phép ngudi dung didu chinh hoat
dong clia man hinh hodc chon cac chirc
nang clia man hinh truc tiép théng qua
moét clra s& huwéng dan hién thi trén man
hinh. Mét giao dién hién thij trén man hinh
dé st dung dwoc thé hién nhw sau:

Mau 200V4Q:

Hwéng dan co ban va don gian vé cac
nat diéu khién

Trong menu OSD minh hoa & trén, ban co
thé nh&n ¥ A cac nat & g& mét trwdc cla
man hinh d& di chuyén con tré va nhan nat
OK dé xac nhan Iya chon hoéc thay dbi.

Menu OSD

Dwai day la tdng quan vé& co ciu cla
menu Hién thi trén man hinh. Ban c6 thé
st dung co c&u nay lam thong tin tham
khao khi muén thuc hién cac diéu chinh
khac sau nay.

Main menu

Input

Picture

Color

Language

OSD Settings

Setup

Sub menu

L

VGA
DVvI

Picture Format — Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
[ SmartResponse — Off, Fast, Faster, Fastest

available for selective models

SmartContrast —— On, Off
Pixel Orbiting — On, Off
Gamma — (1.8,20,22,24,26)
Color Temperature — 6500K, 9300K
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100

English, Deutsch, Espariol, ENAnvikn, Francais, Italiano,
Maryar, Nederlands, Portugués, Portugués do Brazil,
Polski , Pycckuit, Svenska, Suomi, Tiirkge, Cestina,
Ykpaicbka, KA, EaEHR L, A AR, 3ol

Horizontal — 0~100

Vertical — 0~100
Transparency — Off,1,2,3,4
OSD Time Out — 55, 10s, 20s, 30s, 60s
Auto

H. Position — 0~100
V. Position — 0~100
Phase — 0~100
Clock — 0~100
Resolution Notification — On, Off
Reset — Yes, No

Information



El Théng béo vé dé phan giai 2.3 Thao dé va chan dé
Man hinh nay dwoc thiét ké d& hoat déng

t6i wu véi do phan giai gbc 1a 1920X1080 E Théo chan aé

@ 60 Hz. Khi dwgc chinh sang d6 phan Trwéce khi bat dau thao chan dé man

giai khac, man hinh sé hién thi mét théng hinh, hay thwc hién theo cac hwéng dan
bao: Dung 1920X1080 @ 60 Hz dé dat két bén dwéi dé tranh moi thiét hai hay chan
qua tét nhét. thwong cé thé xay ra.

Ban c6 thé tat théng bao hién thi d phan 1. Bat man hinh nam sap trén bé mat
giai gbe tr muc Setup (Cai dat) trong min, can than de tranh lam tray xwoc
menu OSD (Hién thj trén man hinh). hoac héng man hinh.

El Tinh nang vat Iy
Nghiéng

2. An vao cac kep khéa dé thao chan dé
ra khai tru dé.




& Note
This monitor accepts a 100mm x 100mm VESA-
Compliant mounting interface.

100mm

100mm




3. T6i wu hda hinh anh

3.1 SmartContrast

B s 1agi?

Cong nghé ddc dao vén linh hoat phan
tich ndi dung hién thj va tw dong tbi wu
héa ty Ié twong phan cia man hinh LCD
dé mang lai d6 rd nét va trai nghiém xem
tbi wu, ting mirc dén nén dé hién thi
nhivng hinh anh sang ré hon, séc nét hon
va sbng dong hon hay gidm mdéc dén nén
@& hién thj rd hinh &nh trén phéng nén téi.
B Sao t6i phai can n6?

Ban mudn hién thi ndi dung rd nét ciing
cam giac thodi mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chinh
dé twong phan va mirc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwe rd, sdng déng va sac nét hay hién thi
ndi dung chir rd rang dé doc cho céac tng
dung van phong. Bang cach gidm viéc tiéu
thu dién ctia man hinh, ban sé tiét kiém
dwoc chi phi ndng lweng va kéo dai tudi
tho cho man hinh cuta ban.

E cach hoat dong?

Khi ban bat ché d& SmartContrast, n6 sé
phan tich néi dung dang hién thj trong
thwe té dé chinh mau séc va mat do den
nén. Chirc nang nay sé linh hoat tang
do6 twong phan dé mang lai cho ban trai
nghiém giai tri tuyét v&i khi xem video
hoac choi game.

3.2 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i cta
Philips cho phép ban diéu khién man hinh
qua giao dién dd hoa 4o tién dung. Cac
diéu chinh phtc tap la nhirng gi thudc

vé qua kh(r vi phan mém than thién voi
nguoi dung nay sé huéng dan ban qua
viéc tuy chinh do phan giai, hiéu chinh
mau, diéu chinh ddng hd/géc pha, diéu
chinh diém trang RGB (Dé-Luc-Lam), v.v...

Trang bi cdng nghé méi nhét vé thuat toan

I6i xC Iy va phan &ng nhanh, phan mém

chay bang anh déng b4t mat thuong thich

véi Windows nay s8n sang nang cao trai

nghiém cuta ban v&i man hinh Philips!

E cai aat

« Thuwc hién theo chi dan va hoan tat quy
trinh cai dat.

+ Ban c6 thé kh&i dong phdn mém sau
khi hoan tat cai dat.

«  Néu mubdn kh&i ddng sau, ban c6 thé
click phim tat phdn mém trén man hinh
nén hodc thanh céng cu may tinh.

Monitor driver and software installation

Wizard (Thuat si) kh&i dong lan dau

+ Lan dau khi cai d&t phan mém
SmartControl Lite, n6 sé ty dong vao
Wizard (Thuat si) khéi déng lan dau.

+ Thuat si nay sé& hwdng dan ban théng
qua viéc diéu chinh tirng buéc vé hiéu
suét man hinh.

+ Sau nay ban ciing c6 thé vao menu
Plug-in (B4 sung) dé bat thuat si.

« Ban c6 thé chinh cac tuy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.
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¥ U.S. Patent No. 6,686,953

Show Me start

Quick View



. “Show Me” (Cho t6i xem) sé& bat
hwéng dan hiéu chinh mau.

. Start (Bat dau) - bat dau quy trinh
canh chinh mau qua 6 bwéc.

. Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

. Tré& vé giao dién chinh Color (Mau),
click nat Cancel (Huy).

. Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwoc
bat. Néu khéng chon muc nay, ban
khong dwoc phép hiéu chinh mau va
tat cac nat khéi dong va xem nhanh.
. Phai c6 théng tin béng sang ché trén
man hinh hiéu chinh.

Man hinh hiéu chinh mau dau tién:

Nt Previous (Trwéc) sé tat cho dén
khi man hinh mau th hai bat 1én.
Next (K& tiép) s& chuyén vao muyc tiéu
tiep theo (6 muc tiéu).

Cubi cfmg,yéo giao dién File>Presets
(File>Cai san).

Nut Cancel (Hly) sé dc')ng giao di(:an
ngwoi dung (Ul) va tré vé trang bd
sung.
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Options>Preferences (Tuy chon>Uu
tién) - Sé chi hoat dong khi chon
Preferences (Ju tién) ttr menu Options
(Tuy chon) sb xudng. Trén man hinh
khéng hd tre twong thich véi chudn DDC/
Cl, chi c6 sén cac thé Help (Tro gitp) va
Options (Tuy chon).

8 smartControl 2- Phiips 22581 (€530715000001) | 2)(X)

SmartControl Lite PHILIPS

+  Hién thi cac cai d&t wu tién hién hanh.

« O vira chon sé bat tinh nang nay. O
chon 1a nut bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duwoc
chon la (Bat) theo mac dinh. Enable
Context Menu (Menu bat thudc tinh)
hién thi cac lwa chon SmartControl
Lite cho Select Preset (Chon cai sén)
va Tune Display (Chinh man hinh)
trong menu thudc tinh khi click phai
vao man hinh nén. Disabled (D3 tt)
sé x6a SmartControl Lite khéi menu
thudc tinh click phai.

+ Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Menu bat thudc tinh hién thi
menu khay tac vu cho SmartControl
Lite. Click phai vao biéu twong khay
tac vu sé hién thj cac ty chon menu
cho Help (Tro giup), Technical Support
(H6 tro’ ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi da tat Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thi EXIT
(THOAT).

Options>Audio (Tuy chon>Am thanh)
- Sé& chi hoat dong khi chon Audio (Am
thanh) tr menu Options (Tuy chon) sb

+  Theo méc dinh Run at Startup (Chay xuong.
khi khé&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé& khong
bat khi kh&i ddng hodc ndm trong
khay tac vu. Cach duy nhét dé bat
SmartControl Lite 1a tir phim tét trén
man hinh nén hoéc ti file chuwong
trinh. Bat ky bo cai dat s&n nao dé
chay khi kh&i dong sé hoat déng

Trén man hinh khéng hé tro twong thich
v&i chudn DDC/CI, chi co sén cac thé
Help (Tro giup) va Options (Tuy chon).

W SmartControl Phips 2258 x

SmartControl Lite PHILIPS

Audio

khéng tai khi 6 nay khong dwogc chon \@ 0
(Pa tat).
+ Enable transparency mode (Bat ché \g, "
do trong subt) (Windows 7/8.1, Vista, s =
XP). Mac dinh la 0% Mo. \(g B
Options>Input (Tuy chon>Nhap) - Sé - 2
chi hoat déng khi chon Input (Nhép) tor o &
menu Options (Tuy chon) sb xudng. Trén \g o §
man hinh khéng hé tro twong thich véi - B

chuén DDCI/CI, chi ¢ s8n cac thé Help
(Tro gitp) va Options (TUy chon). T4t ca
céac thé SmartControl Lite khac déu khong
c6 sén.

8 smartcontol 2-phips

Help>User Manual (Tro’ gitip>S6 tay str
dung) - Sé chi hoat dong khi chon User
o) 2% Manual (Sé tay s dung) t&» menu Help
(Tro gitp) s6 xubng. Trén man hinh khéng
hé trg twong thich véi chudn DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options
(Tay chon).

W smartcontol 2. phip

PHILIPS

SmartControl Lite

s 22581 (C530715000001) |2 (X,

PHILIPS

Adiust

e

SmartControl Lite

User Manual

Optons Pt Adiust ug :
a . 4

e = -
= w0
Help Color ?‘

+ Hién thi giao dién hudng dan Source g -
(Nguon) va cai dat ngudn nhap théng \1;
tin hién hanh. o,

» Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thj.
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Help>Version (Tro’ gitup>Phién ban) - S&é
chi hoat déng khi chon Version (Phién
ban) tr menu Help (Tro gitp) sé xubng.
Trén man hinh khéng hé tro' twong thich
v&i chudn DDC/CI, chi c6 sén cac thé
Help (Trg gitp) va Options (Tuy chon).
B smartcontrol 2-Phiips 22581 (CS3071:

s000001) ()%

SmartControl Lite PHILIPS

User Manual

Adiust

Options

-/

Menu nhay cam vé&i thudc tinh

Theo mac dinh, Context Sensitive Menu
(Chinh theo thuéc tinh) s& dwoc Bat. Néu
da chon Enable Context Menu (Bat thuéc
tinh) trong giao dién Options>Preferences
(Tuy chon>UWu tién) thi menu nay sé hién
thi.

@ SmartControl
Helect Preset 3
Tune Display

Menu Thudc tinh c6 ba muc nhéap:

« SmartControl Lite - khi da chon, About
Screen (V& man hinh) s& hién thj.

+ Select Preset (Chon cai dat sén) -
Cung cAp menu cac muc cai sn da
lwu theo trinh ty dé& s dung ngay.
D4u kiém sé& hién thi muc cai sdn hién
da chon. Muc Factory Preset (Cai sén

14

gbc) cling co thé duoc chon tir menu
s6 xubng.

+ Tune Display (Chinh man minh) - Mé&
bang diéu khién SmartControl Lite.

+  Smartlmage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Da bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
bang cach click phai vao biéu twong
SmartControl Lite ttr khay tac vu. Click trai
sé bat (rng dung.

Help

Technical Support
Check for Update
About

Exik

Khay tac vu c6 nam muc nhap:

* Help (Trg giup) - Truy cép file User
Manual (Sé tay st dung): M& file User
Manual (Sé tay st dung) qua cira sb
trinh duyét mac dinh.

+  Technical Support (HS tro' ky thuat) -
hién thi trang hd tro' k§ thuat.

+  Check for Update (Kiém tra cap nhat)
- d&n nguoi dung dén Nén (rng dung
PDI va kiém tra phién ban clia nguoi
dung so vé&i phién ban cé s&n méi
nhét.

* About (V&) - Hién thi thong tin tham
khdo chi tiét: phién ban san pham,
théng tin vé phién ban va tén san
phim.

» Exit (Thoat) - Béng SmartControl Lite.

pé chay lai SmartControl Lite, hdy chon
SmartControl Lite ttr menu Program
(Chwong trinh), click ddi biéu twong PC
trén man hinh nén hoac khai dong lai hé
théng.



PHILIPS

SmartControl

‘SmartControl
‘Version 3.20
ctune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Pertrat Displaye, In.
Paterts Pending

P4 tat menu khay tac vu

Khi da tat Khay tac vu trong thu muc

wu tién, chi con co sén Iwa chon EXIT
(THOAT). B& x6a hoan toan SmartControl
Lite khdi khay tac vu, hay tat Run at
Startup (Chay khi khé&i dong) trong
Options>Preferences (Tuy chon>Uu tién).

equy

Tét ca cac hinh minh hoa trong phan
nay chi dwoc dung dé tham khao. Chuing
t6i co thé thay ddi phién ban phan mém
SmartControl ma khéng can théng bao
trwde. Vui long ludn truy cap trang web
chinh thrc cta Portrait tai www.portrait.
com/dtune/phl/enu/index dé tai vé phién
ban phan mém SmartControl m&i nhét.
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4. Cac théng sé ky thuat

Hinh anh/Man hinh

DAu vao tin hiéu

Loai mat man hinh MVA LCD

Deén nén LED

C& man hinh Rong 19,53 inch (49,6cm)
Hé sé co 16:9

Do pixel 0,23 x 0,22 mm

Do sang 250 cd/m?

Do twong phan thong minh 10,000,000:1

D6 twong phan (chuan) 3000:1

Thoi gian dap (rng (chuén) 20ms(200V4QSB)
SmartResponse 8ms(GtG)(200V4QSBR)

D6 phan giai toi wu 1920x1080@60Hz

Goc xem 178° (H) / 178° (V) @ C/R > 10
Mau man hinh 16,7 triéu mau

Tbc do phat doc 56Hz - 76Hz

Tan sb ngang 30kHz - 83kHz

sRGB (Pé-Luc-Lam chuan) | CO

DVI (KTS), VGA (Analog)

Tin hiéu vao
Tién ich
Tién ich cho ngwoi dung

Ddng bd riéng, Bdng bo véi tin hiéu xanh luc

AaTo/Y /A 0-/4 /0K 0}

Ngén ngir OSD (Hién thj trén
man hinh)

English, Deutsch, Espafiol, EMnvikr), Francais, Italiano, Maryarn,
Nederlands, Portugués, Portugués Brazil, Polski, Pycckui,
Svenska, Suomi, Tiirkce, Cestina, VipaiHcbka, i /& H1 3¢,
b, HAR, 8=0

Tién ich khac

Khéa Kensington

Tuong thich voi chuén Plug
& Play (C&m vao Ia phat)

DDC/CI, sRGB, Windows 7/Windows 8.1/Vista/XP, Mac
OSX, Linux

Nghiéng -5 /+20
200V4QSB:
Ché d6 bat 22,9W (chuén), 23,47W (tdi da)
Ché dd ngu (cho) 0,5W
T4t 0,5W
DBén bao LED ngudn Ché do bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)
B6 nguén Thir néng, 100-240VAC, 50-60Hz
200V4QSBR:

Nguén dién
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Ché d6 bat 23,21W (chuén), 24,17W (t6i da)

Ché dd ngu (cho) 0,5W

Téat 0,5W

Dén bao LED ngudn Ché d6 bat: Ché dé Trang, Chd/Ngu: Tréng (nhap nhay)
Bo ngudn Thir néng, 100-240VAC, 50-60Hz

San pham kém theo dé gitr
(Réng x cao x day)

479 x 369 x 201 mm

San pham khong kem theo
dé gilr (ROng x cao x day)
Trong lwong

San pham kém theo dé gitr

479 x 299 x 48 mm

2,72kg

Séan pham khong kem theo
dé gitr

2,39%g

Diéu kién hoat dong

binh gitra cac sw cd)

Pham vi nhiét d6 (hoat déng) | 0 °C - 40 °C
Pham vi nhiét d (Khong 20 °C - 60 °C
hoat dong)

Do am twong déi 20% - 80%
MTBF (Th&i lwgng trung 30.000 gi&

Chj thi ROHS (Gi¢i han cac
chat gay hai)

co

EPEAT(Quy dinh c6 thé khac
nhau tuy qubc gia ctia ban)

Bac (www.epeat.net)

Thung dwng

Cé thé tai ché 100%

Céc chét cu thé

Thung dwng 100% khoéng chira PVC BFR

Energy Star(Quy dinh co thé
khac nhau tuy qubc gia cla
ban)

Tuan thu va tiéu chuan

Phé chuén theo quy dinh

Vo6 ngoai
Mau

co

CE Mark, FCC Class B,TCO Certified, ETL, ISO9241-
307,EPA, UKRAINIAN,CEL, China RoHS, CCC, CECP PSB,
WEEE, CU,C-tick

Pen

L&p son ngoai

Bong lang/Hoa van

© Ghichu

1. Vang hay bac EPEAT chi c6 hiéu lwc tai noi ma Philips da d&ng ky san phdm. Hay truy
cap www.epeat.net dé biét tnh trang dang kw tai quéc gia cta ban.

2. DU liéu nay chiu sw thay di ma khéng can théng bao trwédc. Truy cap www.philips.com/
support dé tai v& phién ban td roi méi nhét.
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www.epeat.net
www.philips.com/support
www.philips.com/support

4. Cac thong s6 ky thuat
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4.1 Ché dd do phan giai & cai
dat san

E D6 phan giai t6i da
1920 x 1080 @ 60 Hz (d4u vao analog)
1920 x 1080 @ 60 Hz (d4u vao KTS)
El D6 phan giai khuyén diing
1920 x 1080 @ 60 Hz (d4u vao KTS)

Tansé Do phangidi Tan sb doc

ngang (kHz) (Hz)
31,47 720 x 400 70,09

31,47 640 x 480 59,94

35,00 640 x 480 66,67

37,86 640 x 480 72,81

37,50 640 x 480 75,00

37,88 800 x 600 60,32

46,88 800 x 600 75,00

48,36 1024 x 768 60,00

60,02 1024 x 768 75,03

44,77 1280 x 720 59,86

63,98 1280 x 1024 60,02

79,98 1280 x 1024 75,03

55,94 1440 x 900 59,89

70,64 1440 x 900 74,98

65,29 1680 x 1050 59,95

67,50 1920 x 1080 60,00

& Ghi cha

Lwu y réng man hinh ca ban hoat déng
tbt nhat & do phan giai gbc 1920 x 1080
@ 60Hz. D& c6 chét lwong hién th tbt
nhét, hay ding d6 phan giai khuyén nghi
nay.
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5. Quan ly nguén dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chuan VESA DPM
vao PC, man hinh c6 thé tw déng giam
tiéu thu dién khi khéng st dung. Néu phat
hién nhap tir ban phim, chudt hay thiét bi
nhap khac, man hinh sé “hoat dong” tw
doéng. Bang sau day sé hién thi mirc tiéu
thu dién va cach truyén tin hiéu cla tinh
néng tiét kiém dién tw déng nay:

200V4QSB:

Binh nghta quan ly nguén dién

Ché do Video Pdng bd| Bdng | Ngudn dién | Mau dén
VESA ngang |bodoc| sirdung LED
A . . 22,9W 2
Hoat dong| BAT Co Co (chuAn) Trang
£ Tréng

Che d0 | 147 | khang | Khong [0,5W (chun)|  (Nhép

ngu (cho) nhéy)
Tit | TAT| - - |05W (chudn)| TAT

200V4QSBR:

Binh nghia quan Iy ngudn dién

Ché do Video Pong bd| Bdng | Ngudn dién | Mau dén
VESA ngang |bddoc| sirdung LED
Hoatdong| BAT | co | c6 fg’hﬁ;‘r’]‘; Tring
£ Tréng
Che do | 147 | khang | Khong [0,5W (chun)| (Nhép
ngu (ch®) nhay)
T&t | TAT| - - |osw (chuan)| TAT

Cai dat sau day dwoc dung dé do mirc

tiéu thu dién trén man hinh.

+ D6 phan giai gbc: 1920X1080

+ Do twong phan: 50%

+ Do sang: 250 nit

. Nhiét dgf) mau: 6500k v&i kiéu mau
trang day da

& Ghichu

D‘CI’ liéu nay chiu sw thay di ma khoéng

can théng bao trudc.
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6. Théng tin quy dinh

(Quy dinh c6 thé khac nhau tuy quéc gia
clia ban)

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an international
third party sustainability certification

for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
independent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

* Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

* Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
halogenated substances and hazardous
flame retardants

*  Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

*  Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

21

* Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

*  Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

* Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.
A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of al TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable IT for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around

the world rely on TCO Certified as a tool to
help them reach their sustainable T goals.We
are owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit
www.tcodevelopment.com

I[u Technology for you and the planet
CERTIFIED

(Only for selective models)



Lead-free Product

Lead free display promotes

@ environmentally sound recovery
ey and disposal of waste from electrical

and electronic equipment. Toxic

substances like Lead has been eliminated

and compliance with European community's

stringent RoHs directive mandating restrictions

on hazardous substances in electrical and

electronic equipment have been adhered to

in order to make Philips monitors safe to use

throughout its life cycle.

EPEAT

(www.epeat.net)

> The EPEAT (Electronic
Qz Product Environmental
)
Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process

supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

»  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

*  2006/95/EC (Low Voltage Directive).

+  2004/108/EC (EMC Directive).

*  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

» TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner; we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.
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4)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission
(FCC) Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

S

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la
Communication (FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences



nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiére de conformité est susceptible
d'interdire a I'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic
Only)

This davice belongs to catagory B devices as described in EN 55022, unless it is spacti-
cally stated that it is a Class A devics on the speciication labal. The following appiies to
devices in Class A of EN 55022 (radius of protection up 1o 30 meters). The ussr of the
devics iz obliged to taks all staps necessary to remove sources of intarfarencs 1o tels-
communication or sther devicss.

Fokud neni na typovém Stitku poitate uvedeno, 28 spadé do do tfidy A podie EN 55022,
spadd automaticky do tfidy B podile EN 55022, Pro zafizenl zefazend do tfidy A (chranné
pésmo 30m) podie EN 55022 plati nésledujicl. Dojde-li k rullen! tslekomunikadnich nebe.
Jinjch zafizani je uZivatal povinnen provést takove opatfgni, aby neni odstranil.

Polish Center for Testing and
Certification Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan | Certyfikacji
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
HAZHENERVRE |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber; der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

() ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

Restriction on Hazardous Substances
statement (India)

This product complies with the “India E-waste
Rule 2011" and prohibits use of lead, mercury,
hexavalent chromium, polybrominated
biphenyls or polybrominated diphenyl ethers
in concentrations exceeding 0.1 weight % and
0.01 weight 9% for cadmium, except for the
exemptions set in Schedule 2 of the Rule.



E-Waste Declaration for India

This symbol on the product or on its packaging
indicates that this product must not be
disposed of with your other household waste.
Instead it is your responsibility to dispose of
your waste equipment by handing it over to

a designated collection point for the recycling
of waste electrical and electronic equipment .
The separate collection and recycling of your
waste equipment at the time of disposal will
help to conserve natural resources and ensure
that it is recycled in a manner that protects
human health and the environ-ment. For more
information about where you can drop off your
waste equipment for recycling in India please
visit the below web link.

http://wwwi.india.philips.com/about/sustainability/
recycling/index.page

Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this type
of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
5AAS.TA. or BSI approved type.

3. Retit the fuse cover

If the fitted plug is not suitable for your socket

outlets, it should be cut off and an appropriate
3-pin plug fitted in its place.

If the mains plug contains a fuse, this should
have a value of 5A.If a plug without a fuse is
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used, the fuse at the distribution board should
not be greater than 5A.

NOTE: The severed plug must be destroyed
to avoid a possible shock hazard
should it be inserted into a 13A socket
elsewhere.

How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL"(“N")
BROWN -“LIVE"("L")
GREEN&YELLOW -“EARTH"(“E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOW.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected
to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain

that the cord grip is clamped over the sheath of

the lead - not simply over the three wires.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products produced and sold for China
market have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year

SNote

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh
man hinh phéng cua Philips
Philips cb géng cung cAp cac san phdm
chat lvong cao nhét. Chung t6i ap dung
mét sé quy trinh san xuét tién tién nhét
trong linh vuc va thuwe hién quy trinh kiém
tra chét lwong nghiém ngat. Tuy nhién, cac
I6i diém &nh hay diém anh con trén man
hinh TFT dung trong cac man hinh phang
dbi khi khong thé tranh khai. Khéng nha
san xuat nao c6 thé dam bao rdng moi man
hinh s& khong ¢ cac 16i diém &nh, nhwng
Philips dam bao réng bét ky man hinh nao
c6 mot sb 16 khong thé chap nhan sé duoc
stra chira hoac thay méi dwa vao chinh
sach bao hanh. Théng bao nay giai thich
nhirng kiéu I6i diém anh khac nhau va dinh
nghia cac mirc 16i cé thé chap nhan cho
mai kiéu 16i. D& hwdng dich vu stra chira
hay thay thé theo chinh s&ch bao hanh, sé
lwong 16i diém &nh trén man hinh TFT phai
vuwot qua cac mie chap nhan nay. Vi du,
khéng qua 0,0004% diém anh con trén man
hinh c6 thé bj I6i. Ngoal ra, Philips tham
con dat ra cac tiéu chuén chét lweng cao
hon cho mét s6 kidu hay két ho’p 16i diém
anh vén d& nhin thdy hon cac kiéu 15 khac.
Chinh sach nay cé hiéu Iyc trén toan cau.

diém anh phu

m \
diém

anh

DPiém anh va diém anh con

Diém anh hay phan t& anh gébm ba diém
anh con trong cac mau chinh dd, luc va
lam. Nhiéu diém &nh cting tao thanh hinh
anh. Khi moi diém &nh con ciia mét diém
anh sang Ién, ba diém anh con co mau sac
cuing hién thi nhw mét diém anh trang don
1&. Khi moi diém anh con t6i m&, ba diém

anh con co mau séc cung hién thi nhw mét
diém anh den don 1&. Nhivng két hop diém

anh con sang va téi khac hién thi nhw cac
diém anh don 18 ti nhitng mau khac.

Cac kiéu 15i diém anh

Cac 16i diém &nh va diém anh con hién thj
trén man hinh theo nhitng cach khac nhau.
Cé¢ hai kiéu 16i diem anh va nhiéu 16i diém

anh con trong méi kiéu I5i.
Cac 16i cham sang

Céc 16i chdm sang hién thi du¢i dang cac
didm anh hay diém anh con vén ludn sang

hay “bat”. Nghia la mon ch&m sang 1a mot

diém anh con vdn ndi 1&n trén man hinh khi
man hinh hién thi kiéu hinh t&i mo. Cé cac

kidu 16i chdm sang.

Mét diém &nh con sang da, luc hay lam.

1 ¢

Hai didm anh con sang gan nhau:
bdé +Lam=Tim
bé + Luc = Vang
Luc + Lam = Lyc lam (Lam nhat)
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Ba diém &nh con sang gan nhau (mot diém
anh trang).

& Ghi chu

Chéam sang dé hay lam phéi sang hon
50% so v&i cac chdm xung quanh trong
khi chdm sang luc sang hon 30% so Vi
cac chdm xung quanh.

Cac 16i cham den

Cac 16i cham den hién thj dwéi dang cac
diém anh hay diém anh con vén luén toi
mo hay “t&t”. Nghia la mdi cham tbi mo
la mot diém anh con vén ndi lén trén man
hinh khi man hinh hién thj kiéu hinh sang.
C6 céc kiéu 16i chadm den.

LOI CHAM SANG

D6 gan cua cac 16i diém anh

Vi céc I6i diém anh va didm anh con cla
cuing kiéu 16i vén gan véi mét kiéu 16i khac
c6 thé dé nhin thay hon, Philips ciing néu
rd cac dung sai vé do gan cla 16i diém &nh

Dung sai 16i diém anh

D& huéng dich vu stra chiva hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phang Philips phai c6 cac 16i diém anh hay
diém anh con vuot qué nhivng dung sai
néu trong cac bang sau.

MUC CHAP NHAN

1 diém anh con sang 3

2 diém anh con sang gan nhau 1

3 diém anh con sang gan nhau (m6t diém anh trang) 0
Khodng cach gitra hai I6i chdm sang* >15mm
Tbng s6 16i chAm sang ctia moi kiéu 16i 3

LOI CHAM BEN MUC CHAP NHAN
1 diém anh con toi m& 5 hoac it hon
2 diém anh con t6i m& gan nhau 2 hoac it hon
3 diém anh con t6i m& gan nhau 0
Khodng cach gitva hai I6i chAm den* >15mm
Tbng s 16i cham den ctia moi kiéu 6 5 hoac it hon

TONG SO LOI CHAM

Tbng s 16i chAm sang hay den ciia moi kiéu 16

MUC CHAP NHAN
5 hoac it hon

& Ghi chu

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chdm
2. Man hinh nay tuan thd chuan 1S09241-307. (IS09241-307: Yé&u cau, phan tich vé hiéu
nang va cac phuong phap kiém tra tuan thi cho man hinh dién td)

3. 1S09241-307 la tiéu chudn tiép theo clia tiéu chuin ISO13406 cii, von da bi hlly bd bdi
T4 chtre Tiéu chuén héa Quéc té (1ISO) vao ngay: 13-11-2008.
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7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 thaéng tin chi tiét vé chinh sach bdo hanh va yéu cau hd tro thém dwoc ap dung cho
khu vuc clia ban, vui ldng truy cap website www.philips.com/support. Ban ciing c6 thé lién
hé v&i Trung tdm cham séc khach hang dia phwong cda Philips theo sb dién thoai dwéi
day.

Théng tin lién lac cho khu vwc TAY AU:

Quéc gia

S6 BT dwong day
néng

Gi® hoat dong

Austria RTS +43 0810 000206 €0.07 Mon to Fri:9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri: 9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri:9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri: 9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri: 9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff [ Mon to Fri:8am - 5pm
Italy Anovo ltaly [ +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri:9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge | Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff [ Mon to Fri:9am - 6pm
Switzerland ANOVO CH | +41 02 2310 2116 Local call tariff [ Mon to Fri:9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - S5pm

Théng tin lién lac & Trung Quéc:
Trung tam dich vu
PCCW Limited

S6 cham séc khach hang
4008 800 008

Quéc gia
China

Théng tin lién lac cho khu viec NAM MY:

Québc gia Trung tam dich vu S6 cham séc khach hang
U.S.A. EPI-e-center (877) 835-1838
Canada EPI-e-center (800) 479-6696
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www.philips.com/support

Thong tin lién lac cho khu viec TRUNG VA BONG AU:

Trung tam
dich vu

Quéc gia

S6 cham séc khach hang

+37517 217 3386
Belarus NA IBA +37517 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300

+372 6519900(General)
Estonia NA FUJITSU +372 6519972 (workshop)
Georgia NA Esabi +995 322 91 34 71

+36 1 814 8080(General)

+36 1814 8565(For AOC&Philips
Hungary NA Profi Service only)
Kazakhstan NA Classic Service ll.c. | +7 727 3097515

+371 67460399
Latvia NA ServiceNet LV +371 27260399
Lithuania NA UAB Servicenet Ig;g ;ZO%%?Sé(()f%ngﬁ?;)s )
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA KimTec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic of Belarus | NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

Théng tin lién lac cho khu vwc CHAU MY LATINH:

Quéc gia  Trung tam dich vu

Brazil

Vermont

Argentina

S6 cham séc khach hang
0800-7254101

0800 3330 856
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Thong tin lién lac cho khu virc Chau A TBD/Trung Béng/Chau Phi (APMEA):

Quéc gia

S6 chiam séc khach

hang

Gio hoat dong

Australia AGOS NETWORK PTY LTD | 1300 360 386 Mon.~Fri. 9:00am-5:30pm
New Zealand | Visual Group Ltd. 0800 657447 Mon.~Fri. 8:30am-5:30pm
Hong Kong Company: Smart Pixels Hong Kong: Mon.~Fri. 9:00am-6:00pm
M Technology Ltd Tel: +852 2619 9639 Sat. 9:00am-1:00pm
acad echnology Hta: Macau:Tel: (853)-0800-987 at-7Abam-TEp
‘ Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS to 56477 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer . AN
rdonesa | PTCORMIC SERVISINDO | Hotline) :43?86-3?;608'30_1 200
PERKASA +62T8888—O1 -9086 (Customer Fri. 08:30-11:30; 13:00-17:30
Hotline)
. Mon.~Fri. 9:00am-5:30pm
Korea Alphascan Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. . Mon.~Fri. 8:15am-5:00pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 Sat 8:30am-12:30am
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore .
: o Mon.~Fri. 9:00am-6:00pm
Singapore Pte Ltd (Philips Consumer Care | (65) 6882 3966 Sat. 9:00am-1:00pm
Center)
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
et ftxd's Computer System Co. | (471 934.5498 Mon.~Fri. 8:30am~05:30pm
South Africa | Computer Repair Technologies |011 262 3586 Mon.~Fri. 8:00am~05:00pm
Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00
+84 8 38248007 Ho Chi Minh
FPT Service Informatic City Iy ) :
Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City :47?;(') SZ: g;gg:g;gg' 13:30-
City Branch +84 5113.562666 Can tho T ’
Province
e i AL (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Armenia
Azerbaijan
Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00
Kyrgyzstan
Tajikistan
Uzbekistan EE’ d“'ko Plus Private Enterprise | 9671 2784650 Mon.~Fri. 09:00 - 18:00
Turkmenistan | Technostar Service Centre +(99312) 460733, 460957 Mon.~Fri. 09:00 - 18:00
T4V TFRAE=L— 5 AR .
Japan H = H— 0120-060-530 Mon.~Fri. 10:00 - 17:00
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8. Khac phuc sw co &
Hoi Pap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw cb vén nguoi
duing c6 thé khéc phuc. Néu sw cb van
tiép di&n sau khi ban da thir dung céac giai
phéap trén trang nay, hay lién hé vé&i dai
dién dich vu khach hang cla Philips.

H cac sw cd thweng gip

Khéng c6 hinh anh (Pén LED nguén

khéng sang) ) . .

+ Dam bao d& cam day nguon vao o
cam dién va mat sau ctia man hinh.

«  Truéc tién, ddm bao nut ngudn &
mét tredc man hinh nam & vi tri OFF
(TAT), sau d6 day nut sang vi tri ON
(BAT).

Khéng c6 hinh anh (Pén LED nguén

sang trang)

+  Dam bdo da bat may tinh.

«  DPam bado cap tin hiéu da dwoc két nbi
dung cach véi may tinh cta ban.

+  Dam bdo cap man hinh khéng cé cac
chéu cdm bj cong trén mat két néi.
Néu c6, hay stra hay thay méi cap.

« C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh théong bao

Attention

Check cable connection

+ Dam bao cap man hinh da duoc két
ndi dung cach véi may tinh cta ban.
(Clng tham khao Hwéng dan khéi
dong nhanh).

*  Kiém tra xem cap man hinh c6 cac
chau cam bi cong hay khéng.

+ Dam bao da bat may tinh.
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Nut AUTO (Tw dong) khéng hoat dong

« Chtrc néng tw ddng chi ap dung & ché
dd VGA- Analog. Néu khong hai long
véi két qua, ban co thé thuc hién cac
didu chinh tht cdng qua menu OSD
(hién thi trén man hinh).

& Ghichu
Chtrc nang Auto (Tw dong) khéng ap dung
& ché do DVI-KTS vi n6 khong can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

+  Khéng thuwc hién bat ky buwéc khdc
phuc sy ¢ nao

+ Ngét ngay két ndi man hinh khdi 6
cam dién chinh cho an toan

* Lién hé ngay vé&i dai dién dich vu
khach hang culia Philips.

B cac swc hinh anh

Hinh anh khéng nam giiva tam man

hinh

+ Chinh vj tri hinh &nh qua chlrc nang
“Auto (Tw dong)” trong cac nut diéu
khién chinh trén menu OSD.

* Chinh vi tri hinh anh qua Phase/Clock
(Géc pha/bdng hd) clia Setup (Cai
dat) trong cac nuat diéu khién chinh
trén menu OSD. N6 chi ¢o hiéu lwc &
ché do VGA.

Hinh anh rung lén trén man hinh

« Kiém tra xem cap tin hiéu da dwoc
cam chét dung cach vao bang mach
dd hoa hay may tinh hay chua.

Hién thij hién twong chap chén doc

* Chinh hinh anh qua chtrc nang “Auto
(Tw déng)” trong cac nat diéu khién
chinh cda menu OSD.



» Loai bé cac vach doc qua Phase/
Clock (Géc pha/Bdng hd) clia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co6 hiéu
lwc & ché d6 VGA.

Hién thi hién twong chap chen ngang

* Chinh hinh anh qua chirc nang “Auto
(Tw doéng)” trong cac nuat diéu khién
chinh ctia menu OSD.

* Loai bé céac vach doc qua Phase/
Clock (Géc pha/Bdng hd) ctiia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwc & ché dd VGA.

Hinh anh hién thi nhoe, khong ré hoac

qua mo

+ Chinh d6 twong phan va do sang trén
menu Hién thj trén man hinh (OSD).

Hién twong “anh ao”, “anh thir nong”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

+ Hién thi lién tuc cac anh tinh trong mot
thoi gian dai c6 thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh béng ma” la hién twong phd
bién trong cong nghé& man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh thr néng” hoadc “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dien.

¢ Ludn bat trinh bdo vé man hinh
chuyén ddng khi ban khéng st dung
man hinh.

e Lubn bat (rng dung Iam m&i man hinh
dinh ky, néu khéng, man hinh LCD
cda ban sé hién thi nhirng ndi dung
tinh khong thay déi.
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» Céac hién twong “anh thir néng” hay
“anh ao0” hay “anh béng ma” sé khong
biét m4t va ban can mang man hinh
di stra. Thiét hai nhw trén khong ndm
trong chinh sach bdo hanh ctia ching
toi.

Hinh hién thj bién dang. Van ban bi m&

hoac nhoe.

+ Cai do phan gidi man hinh may tinh
sang cung ché dd v&i dé phan giai
man hinh gbc khuyén diing ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thi trén man hinh

+ Céc cham con lai la d4c tinh théng
thwéorng cGia man hinh tinh thé 1éng
dung trong cdng nghé ngay nay. Vui
léng tham khao chinh sach diém anh
dé biét thém thong tin.

DPén “bat ngudn” qua sang va gay choi

mét

+ Ban c6 thé chinh dén “bat ngudn” qua
Cai dat dén LED ngudn trong cac nut
digu khién chinh ctia menu OSD.

Pé duwoc tro gitip thém, hay xem danh
sach Trung tdm thong tin khach hang
va lién hé va&i dai dién dich vu cham séc
khach hang cta Philips.



8.2 Héi bap chung

H1:

Khi cai cai dit man hinh, t6i can
lam gi néu man hinh hién thj
“Cannot display this video mode”
(Khong thé hién thi ché do video
nay)?

Pap: B6 phan giai khuyén dung cho man

hinh nay la: 1920X1080 @ 60 Hz.
Ngat tAt ca cac cap roi két néi PC véi
man hinh ma ban da dung trwéc dé.
Trong Windows Start Menu (Menu
kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang didu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twong Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé “Settings”
(Cai dat). Trong thé cai dat, trong 6
co tén “desktop area (vung man hinh
nén)”, chuyén thanh trwot sang murc
1920X1080 pixels.
Mé& thé “Advanced Properties” (Thuéc
tinh nang cao) va cai Mic cap nhat
(Refresh Rate) sang 60Hz rdi click
OK.

Khéi dong lai may tinh va lap lai bwéc
2 va 3 dé kiém tra xem PC clia ban da

dwoc cai sang mrc 1920X1080 @ 60
Hz hay chwa.

TAt may tinh, ngét két ndi man hinh
cli va két ndi lai man hinh LCD Philips
cta ban.

TAt man hinh réi bat lai PC.

H2: Mirc cap nhat khuyén dung cho

bap:

man hinh LCD la bao nhiéu?

Murc cap nhat khuyén dung cho man
hinh LCD 13 60Hz. Néu c6 bt cty
hién twong nhiéu nao trén man hinh,
ban cé thé cai dat mrc nay sang
75Hz dé kiém tra xem mirc méi nay
¢0 loai bd dugc hién twong nhiéu
hay khong.
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H3:

bap:

H4:

bap:

H5:

bap:

H6:

bap:

H7:

bap:

Cac file .inf va .icm trén dia CD

1a gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Day la céc file driver cho man hinh
cla ban. Thuec hién theo cac chi dan
trong s tay str dung dé cai dat cac
driver nay. May tinh c6 thé yéu ciu
ban cai cac driver man hinh (file .inf
va .icm) hodc Iap dia driver khi ban
cai dat man hinh lan dau. Thyc hién
theo cac chi dan dé I&p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
dwoc cai dat ty dong.

Lam thé nao dé chinh do phan giai?
Card video/driver db hoa cla ban

va man hinh sé ciing quyét dinh

cac do phan giai c6 sin. Ban co thé
chon dd phan giai mong mudn trong
Control Panel (Bang diéu khién)

clia Windows® qua thé “Display
properties” (Thudc tinh man hinh).
Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nat OK rdi chon
“Reset” (Cai dét lai) d& phuc hdi moi
cai d&t mac dinh gbc.

Man hinh LCD c6 kha niang chéng
tray xwérc?

N6i chung ban khéng nén dé& bé mat
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khai cac
vat dung sac hay cun. Khi cAm man
hinh, d@m bao khong dung strc ép
hay lwc manh 1&n phia b& mat man
hinh. Diéu nay cé thé anh hwéng
dén cac diéu kién bao hanh cda ban.

T6i nén lau man hinh LCD nhw thé
nao?

Dé lau thong thuong, hay sir dung
khan sach va mém. Bé lau ky, hay
duing cdn isopropyl. Khéng dung
cac dung méi khac nhw con étylic,
ethanol, axeton, hexan, v.v...



H8: T6i c6 thé thay déi cai dit mau
séc cho man hinh?

DPap: DI nhién, ban cé thé thay dbi cai
dat mau sic qua nut didu khién trén
menu OSD theo cac quy trinh sau,

. Nhén “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

. Nhan “Down Arrow” (Mi tén
xudng) dé chon tuy chon “Color”
(Mau) rdi nhan “OK” dé vao cai dat
mau; c6 ba Iwa chon mau nhu sau.

1. Color Temperature (Nhiét d6 mau);
Hai cai dat gdm 6500K va 9300K.
V@i cac cai dat trong pham vi
6500K, man hinh sé hién thj “néng
véi tin hiéu mau dé-trang", trong khi
nhiét do 9300K tao ra “mat v&i tin
hiéu mau lam-tréng’.

2. sRGB (Pd-Luc-Lam chuén); day
la cai d&t chudn dé& dam bao trao
ddi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon); nguwdi dung
c6 thé tw chon cai dat mau sac wu
tién bang cach chinh mau dé, luc va
lam.

& Ghichu
Do mau anh sang téa ra ttr mot vat dung
trong khi né dwoc lam néng. Sé do nay
dwoc thé hién dwa trén ty 1& tuyét déi, (mirc
dd Kelvin). Cac mirc nhiét dé Kevin thap
hon nhw 2004K la mau dé; cac mire nhiét
dod cao hon nhw 9300K la mau lam. Nhiét
dé trung tinh 1a mau tréng & mirc 6504K.
H9: Téi c6 thé két n6éi man hinh LCD
vé&i moi PC, may chu hay may
Mac?
DPap: C6 thé. TAt ca cac man hinh LCD
Philips d&u hoan toan twong thich
v&i cac PC, may Mac va may ch
chuan. Ban c6 thé can cé dau noi
cap dé két ndi man hinh méi hé
théng may Mac. Vui Idng lién hé voi
nhan vién kinh doanh ctia Philips dé&
biét thém théng tin.

H10: Man hinh LCD Philips cé hé tro
chuén Plug-and-Play (Cadm vao la
phat)?

DPap: C6, cac man hinh Philips déu h tro
chuén Plug-and-Play twong thich
v&i Windows 7/Windows 8.1/Vista/
XP/NT, Mac OSX, Linux

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

DPap: Hién thj lién tuc cac anh tinh trong
mot thdi gian dai cé thé gay ra hién
twong “anh th&r nong”, con dwoc
goi la “anh ao” hay “anh bong ma”,
trén man hinh cta ban. “Anh thi
néng”, “Anh ao” hay “Anh béng ma”
I& hién twong phd bién trong cong
nghé man hinh LCD. Trong moi
trwong hop, hién twong “anh thir
néng” hay “anh ao” hay “anh béng
ma” sé bién mét dan trong mét thoi
gian sau khi da tat nguon.

Luén bat trinh bao vé man hinh
chuyé&n ddng khi ban khéng st
dung man hinh.

Ludn bat vng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD cla ban sé& hién thj nhirng noi
dung tinh khéng thay ddi.

O canh bao

Khéng thé bat anh bao vé man hinh, hoac
trng dung cap nhat man hinh dinh ky co
thé gay ra cac sw ¢ “thtr néng” hodc “anh
sau” hoac “anh bong ma” nghiém trong
vbn sé& khong bién mét va ciing khéng

thé khac phuc. Thiét hai vira néu khéng
bao gbm trong chinh sach bao hanh cla
chung téi.

H12: Tai sao man hinh cua t6i hién thj
van ban sac nét va cac ky tw ring
cwa?

Dap: Man hinh LCD clia ban hoat
doéng tét nhat & dod phan giai gbc
1920X1080 Hz. D& man hinh hién



thi tét nhat, vui long st dung dd
phan giai nay.
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